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Especialidades Medicas Myr, S.L. would like to thank you for the purchase of this
equipment and for your confidence in choosing our company.

We are committed to offer you the best and most reliable service.

Don’t hesitate to contact your local dealer for any question related to this Slide Stainer.

Your Especialides Médicas Myr, S.L. team



Contents

Slide Stainer

40X o 11T oY 0 4
1 (=T o [T o I 1= 4

R AT =T = 4
Certification.........cooeee e 5
Safely .o ————————— 5
Safety Precautions ... 6

P V2= o [ 6
DoCUMENTAtION ... 8
Conditions for the transportation of the instrument...........................cc 8
Technical data............cooviiiiiiiiiiiiii i —————————————— 9
Reception and installation of the unit............ccccoorririrrnr s 10
O] ] 0 1= o3 1] o 1R 11
Connecting to the MaiNS.........cooviiiiiiiiiiiiieeeeeeeeee e 11

Water inlet and OUtIEt .............uueeeeiiii e 12

Rinsing trough water connection............c..ooooiiiiii e, 12
COMMISIONING ... e e e 13
T (oo 11 T3 1T o 13

Slide stainer CompoNENES .........ooiiiiiiiii e 16
Display screen and KEYPAd .........cooeeiiiiiiiiii it 16
Menus and OPLIONS ......coeeiii i, 17

=T 0 0= o O 17
Configurations and Settings........c.oooiiiiiiiiiiiiiiiieieeeeeeeeeeeeeeeeeeeeeeee e 18

Advanced configurations............cccoeee i 21
Programming .....c....coiiiiiiieiceecssssserrssssssssss s s rrersrssmassssssssserrnnmsssssssssermesnnnsssssssseenennnnnnns 22
Preparation ... 22
Listof reagents...........oooiiiiiiiiii e 22
Preparation of programmes...........cccoeee i, 23

REAGENT MAP ... 26

Reagent and programme editing ...........uoei i 27
Editing reagents list........ooereii i 27

Entering programmes..........coooo oo 30
Programming with PC........... 31
Connecting the equUIPMENTt .........cooiiiiiiiiieeeeeeeeeeeeee e 31

Installing the programme............oouiiiiiiiiie e 31

Running the software ... 31

(070 a1 ilo ] =1 i o] o PP 32

File MEeNU ..o, 33

Creating @ Programime ............eeeiiiiiiiiiiiei e e e e 34

Reading and writing programmes ..........c.ccoovveiiiiiii e e 35

Tabs “Info, Settings and LOgS” ..........uuuuiuiiiuiiiiniii e 38

“History” tab (Only SS-30H) .......coiiiiiiiiiiiie e 39

RUNNING @ PrOCESS ....coiiiiiiiiiiinerir s s nnn e 42
o T=To g T T T yoTe7=To [ TR 42
MONItOriNG the PrOCESS .....ceviiiiiii e 45
UNIOAdiNG PrOCEAUIE ......eeiiiiiiiiiiiiee ettt e e e e e e e e e e e 46
Alarm and attention MESSAQES .......ccvvvviiiii i 47
Battery 0peration ... 48
MaINEENANCE ... s 49
Routine maintenance...........coooo i 49
Cleaning ..ccce e 49
Replacing the fIlter...........eeiiii e 50

Disposal of the instrument after final shutdown ..., 51
Replacement part codes for the SS-30 slide stainer..........ccccccciieiiicriicciicciiccicccnne, 51
Programming fOrm ... s 52
Reagent Map ...t 53



Slide Stainer

Introduction

Intended use

Warranty

The Slide Stainer MYREVA SS-30 is an automatic programmable device
for Cytology and Histology processes. It is composed of a metallic chassis
holding reagents troughs, washing troughs, robotic arm X/Y and electric
fun with active charcoal filter. The instrument also features a transparent
cover with three hinged doors.

Before operating the instrument, please read these instructions carefully
to familiarize yourself with its proper operation and functions.

The Slide Stainer is a highly efficient, easy to handle device, developed
taking into consideration the practical needs of professionals.

Only skilled or specially trained personnel must operate the instrument.
The marked safety measures as well as the regulations of your respective
lab must strictly be observed.

The MYREVA SS-30 is a high-performance automatic slide stainer used
exclusively for the staining of histological, cytological and haematological
samples.

No use other than that indicated in this manual is permitted. Its use for
purposes other than those specified shall result in the automatic invalidation
of the manufacturer’s warranty.

The Myr product is warranted against defects in material and workmanship
for a period of 1 year.

Parts which prove to be defective during the warranty period will be repaired
or replaced free of charge.

No other warranty is expressed or implied.

Unauthorized modification or repair by third party persons will void the
warranty.

The warranty will expire in case of improper or wrong use of the instrument
and in case the warning and precautionary messages are not observed.

Especialidades Médicas Myr, S.L. is not liable for any occurring damage.

Once the guarantee period has expired, a maintenance contract should be
signed to ensure the unit is kept in optimum operating condition. For more
information on maintenance contracts, please contact your local distributor.
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Especialidades Médicas Myr, S.L. certifies that this instrument has been
tested and checked carefully. All technical data were checked before
delivering to guarrantee that fulfill published specifications.

The instrument complies with applicable international safety regulations.

Intertek

The installation and normal use of the Slide Stainer is simple and safe if you
observe the instructions given in this manual.

Should the equipment be used for unauthorised purposes or uses not
specified by the manufacturer, safety may be impaired.

Input and output circuits are isolated from the main power supply.
However, those situations which could be constitute a risk for laboratory

personnel or equipment, are distinguished in this manual with the following
symbols and warning messages:

This sign, symbolizing DANGER, means that injury to persons as well as
material damage to the unit may occur if these instructions are not observed.

For your own safety, observe these instructions carefully.

This sign, symbolizing CAUTION, means that damage to the unit may occur
if these instructions are not observed.
For a long service life of the unit, observe these instructions carefully.

The symbol shown here indicates areas where the temperature may
exceed 60°C

This INFORMATION sign draws the user’s attention to important details and
additional information about the device, and should therefore especially be
taken into account.

All persons who are required to operate and programme the Slide Stainer
should read and fully understand these instructions before using the device.

Warning of biological danger.

Warning of radioactive danger.
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Safety Precautions

Hazards

The operator's safety is affected, when the instrument is not operated in
accordance with this instruction manual.

Apart from the instructions given in this manual, the personnel involved in
operating the Slide Stainer should know and observe the general guidelines
and rules for safety and hygiene applicable to the workplace where the unit
is installed.

Please observe the following general precautions during operation of this
instrument. Failure to comply with these precautions violates safety
standards and the intended use of the instrument. Especialidades Médicas
Myr, S.L. is not liable for misuse of the instruments and failure to comply
with basic safety requirements.

Instrument grounding

The instrument is supplied with a 100/240 V ~umains adapter with a 12V
output transformer—. The power outlet must be connected to the protective
earth and must meet the International Electrotechnical Commission (IEC)
regulations.

Danger in explosive environment

The instrument must not be operated in the presence of flammable gases.
Moreover, the instrument must not be exposed to conditions whereby
dangerous gas concentrations can occur.

As there is a risk of fire if working with an open flame (e.g. Bunsen burner)
near the equipment (solvent vapours), a minimum distance of 2 metres
between the flame and the slide stainer should be maintained.

Hazard of radio-active radiation

When working with radioactive specimens observe all applicable radiation
safety procedures. When working with radioactive contaminated material,
appropriate safety and disinfecting measures must be carried out. According
to the rules and regulations concerning the handling of radioactive
contaminated material of the respective laboratory, safety clothing (e.g.
particle mask, gloves, protective shoe covers) must be worn. Radioactive
contaminated waste must be disposed of according to the respective
regulations.

Chemical hazard

When working with the Slide Stainer, sometimes it is necessary to handle
flammable, dangerous fluids. Only trained and qualified laboratory
professionals, being aware of the potential dangers and being capable of
handling those fluids properly, are allowed to use the instrument.

Before handling dangerous liquids, you must make sure to have read and
understood the MSDS and specifically understood the safety instructions and
the instructions for proper disposal.

Wastewater treatment

According to environmental regulations, the occurring waste water should be
drained into a discharge channel with subsequent biological/chemical
purification.
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When the instrument is not in operation, the reagent troughs
should be covered with the plastic lids supplied to minimise
reagent evaporation.

Fume accumulation

Remember that, when working with the device, reagent fumes that are
harmful to health always form. The Slide Stainer should always operate with
the active carbon filter fitted or the discharge duct connected to a fume
extraction system.

To prevent the accumulation of fumes that can damage the internal
components of the machine: NEVER TURN OFF THE MACHINE WITH
THE SWITCH WHILE REAGENTS REMAIN INSIDE. Leave the machine
in sleep mode to enable the programmed extraction cycle to be performed.
See page 21.

Hazard of infection

Specimens used during the intended operation of the instrument might
potentially be infectious. For this reason, it is recommended to observe the
general laboratory regulations concerning protection against danger of
infection. Information on decontamination media, their use, dilution and
effective range of application can be read in the Laboratory Biosafety Manual:
1984 of the World Health Organization.

When working with infectious material, appropriate safety and disinfection
measures must be carried out. According to the rules and regulations
concerning the handling of infectious material of the respective laboratory,
safety clothing (e.g. particle mask, gloves, protective shoe covers) must be
worn. Infectious waste must be disposed of according to the respective
regulations.

Burn hazard
The drying station can reach high temperatures. Take care not to get burned.

Hazards associated with faults caused by electromagnetic interference
To avoid the hazard of malfunction of an instrument, it must only be operated
in a controlled electromagnetic environment. This means that transmitters
such as mobile phones must not be operated in their close vicinity.

In case of malfunctions and/or service work, please turn off the instrument
and contact your local dealer.

Hazards associated with the device’s moving parts

Due to the potential hazards associated with the operation of devices with
moving parts, the Slide Stainer must only be used by professionals or
properly-trained personnel. We recommend that the unit should not be
handled with the cover open, except during loading and unloading, and in
accordance with the safety conditions detailed below. To avoid danger,
moving speed has been reduced.
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Documentation
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This instruction manual will be supplied together with each instrument.
Further copies can be ordered at the Technical Service Address by giving
the serial number of the instrument, the version of the instruction manual
and the date of issue.

This instruction manual is available in English and Spanish

Errors and omissions excepted. Subject to amendment and improvement
without further notice.

Conditions for the transportation of the instrument

©

Repair or maintenance work are normally carried out at the site of
installation. If this is not possible for some special reasons, the instrument
can be returned to Myr. The contact address can be found at the end of this
instruction manual.

For transportation outside closed buildings use the original packing.
If the original packing is no longer available, please contact your local Myr
representation.
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General information

Power Requirements

Through a transformer:
Input: 100 — 240V ~, 1.5A, 50 - 60Hz
Outpu: 12V —, SS-30: 5.5A — SS-30H: 12.5A

Water supply

Supply:
Running water
Maximum pressure: 4 bar
Water temperature: Less than 30°C (86°F) without freezing
Fitting: Standard %4”
Drainage:
By gravity
Pipe diameter: 20 mm

IEC 1010

Protection class 1

Classification in accordance with

Pollution degree 2

Overvoltage category Il

Operating conditions

10 - 40°C
10 - 80% non-condensing

Operating temperature range:
Relative air humidity:

FOR INDOOR USE ONLY

Dimensions and weight

Dimensions

1200 x 440 x 368 mm (W x D x H)

Weight when unloaded and
without packaging

55 kg

Total weight with packaging

92 Kg

Transportation and packaging
conditions

Temperature: -20°C to +50°C

Operating capacity

Processing capacity

Up to 5 racks at a time, depending on the programmes, load
frequency and device configuration.
Simultaneous performance of up to 5 different staining protocols

Load capacity per rack

30 slides

No. of programmes in the
memory

Stores up to 20 programmes, each with up to 50 steps

No. of reagents in the memory

Maximum 52 (49 user-configurable)

Immersion time

1s-59m59 s per step.

Number of stations 20

Reagent stations Maximum 18
Reagent tray volume 300 ml
Cleaning stations Maximum 3
Loading stations Maximum 2

Unloading stations

SS-30: Maximum 3

SS-30H: Maximum 3 (2 with drying chamber active)

Fume extraction

Active carbon filter

Battery life

2 hours (lithium-ion batteries)

Only batteries approved by the manufacturer are
permitted to be used

/N
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Reception and installation of the unit

10

Items included in the box

Before removing the Slide Stainer from their shipping package, carefully
inspect the wooden case for any damage which may have occurred during
transport. Should you detect any sign of damage, do not open the case and
immediately report the situation to the transport agency.

After removing instrument from its package, inspect it carefully for damage.
Should any be noted, immediately notify the distributor from whom the unit
was purchased.

Remove the protective pieces and elements used for transportation. Please
keep the original packaging and protective pieces in case the device needs
to be returned.

Check that the following items have been supplied:

¢ Basic device SS-30
e 20 reagent troughs

e Basic device SS-30H

e 18 reagent troughs

e 2 drying troughs

e 1 power supply with transformer | ¢ 1 power supply with

12V =—=5,5A transformer 12V — 12,5A

3 complete water troughs with fittings.

3 water supply tubes with fittings for water troughs
1 tool to cut the trough water supply tubes

23 plastic lids for the reagent troughs

3 racks + supports (30 slides)

1 active carbon filter

1 mains adapter with transformer 12V — 5A

1 power cable

1 USB cable for connection to PC

1 water supply hose (1.5 m) complete with %” connection fittings
1 corrugated drain hose (3 m)

1 set of clips for drain hose

1 spirit level

1 user manual

Remove the protective elements securing the robotic arm. Do not attempt to
move it manually. The robotic arm will move to its starting position the first
time the instrument is turned on.

When choosing where to install the instrument, as well as its dimensions, also
take into account its weight. See the dimensions and weight on page 9.

The installation site must be well ventilated and free from any flame or source
of sparks.

Place the instrument on a stable and level surface. Use the spirit level
supplied to ensure that the Slide Stainer is installed to facilitate the flow of
water to the drainage area.

Make sure that there is enough space to fully lift the covers and allow air to
circulate.
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The fume extractor outlet is located at the back of the instrument. For correct
ventilation of the instrument a minimum space of 100 mm from wall should
be kept free.

> 100 mm

Connection

Connecting to the mains

CAUTION

Electronics of the Slide Stainer are protected and screened. However, the
instrument should not be sited near to heavy electrical machinery
generating heat, vibrations or strong electrical noises.

The slide stainer is supplied with a power cable and transformer to be
plugged into a standard socket with earth connection. The power supply
socket is on the right-hand side of the device.

1 Power switch
2 USB port
3 Power supply socket

Mains adapter USB cable

11
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Water inlet and outlet
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The water inlet is connected to a standard household appliance hose with
a % threaded fitting supplied with the device. The water supply must be
equipped with a stopcock (not supplied) to enable it to be turned off.

Myr accepts no responsibility for the connection between the water supply
and the equipment.

L]

The hose supplied for connection to the water outlet has an inner diameter
of 20 mm and must be attached to the outlet nozzle with the hose clip
supplied.

Be sure that the drain level is always at a lower level than the unit and the
hose is always hanging downwards.

Remember to shut off the water supply after working with the device.

Rinsing trough water connection

One of the main features of the Slide Stainer is its modularity and adaptability
to user needs.

The Slide Stainer can have up to three rinsing troughs with water in any
station between 5 and 17.

To determine in which stations the water troughs should be located, consult
the person responsible for programming or the pathologist, who will
determine the optimum positions for the type of process to be performed.

In stations 18, 19 and 20, there are three water outlets with rapid self-locking
fittings, which have to be connected, with the flexible hoses supplied (cut to
a suitable length), to the troughs in the stations that have been selected as
rinsing troughs.

The length of the tube (L) will depend on the position of the water intake
station and the destination station.

| L

e [ ]

ﬁJ



©

Commisioning

Introduction

SS-30H

Slide Stainer

Length L in mm is calculated with the formula: (Nt - Nc) * 55 - 16
Nt is the number of the station in which the water inlet is located.
Nc is the number of the station containing the trough to be connected.
55 is the distance in mm between the troughs and water inlets.
16 is the measurement in mm taken up by the fittings.

It is recommended that you use the outlet of station 18 to feed the station
closest to the beginning, station 19 for the middle one and station 20 for the
one nearest the end.

Remember that the way that the water troughs are arranged will be
determined by the processes to be carried out in order to optimise the
performance of the Slide Stainer.

For the example processes shown here, the optimum stations are 6, 8 and
10, which have lengths L of 644 mm, 589 mm and 534 mm respectively. See
the Reagent map on page 23.

If you are using the Slide Stainer for the first time, before you start any real
staining processes, you are strongly advised to familiarise yourself with the
handling and programming of the device. To do so, we suggest that you
perform some process simulations without samples or reagents. You can
allow the water troughs to be filled, which will also verify that they can fill up
and drain correctly.

Before starting to work with the Stainer, it is advisable to perform a status
check. Check the following:

Power Requirements
Check that the power switch is on and that voltage is reaching the device.
The window in the bottom left-hand corner illuminates, except when it is
being powered by the backup battery (for more information about
autonomous operation with the backup battery, see page 48). The display
screen also illuminates.

Water inlet and outlet

Check that the stopcock for the device’s water supply is turned on and the
drain connected. On page 20, you will find the procedure for forcing the entry
of water into the previously-connected troughs and verifying that it is
functioning correctly.

Troughs

The Slide Stainer is equipped with 20 stations, which correspond to the
location of 20 troughs. The first ones are used for loading racks and the last
ones for unloading.

Station 20 of the SS-30H slide stainer can also be used as a
drying/dewaxing station. For this, it features a special trough (marked with
an H) with a side opening to enable the samples to be dried (see next page).

13
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Only SS-30H

Check that the 20 troughs are positioned correctly and not inverted. If they
are not positioned correctly, significant mechanical problems can occur.

To prevent the reagents from overflowing, the troughs should only be filled
up to the level indicated on the inner recess.

Note that the reagent that each trough should contain is determined by the
previously-established Reagent map. See page 23.

The number of loading troughs can be set at 1 or 2 and unloading troughs
at:

Model SS-30 Model SS-30H

1,20r3 1, 2 or 3 (without drying trough)
1 or 2 (with drying trough)

When you use the drying trough in station 20, and given that it cannot in
this case be used as an unloading station, place an empty trough into
station 19 and programme it as an unloading station from the programmes
that use drying station 20.

The drying trough is labelled with an “H”. Make sure that it always occupies
station 20 if it is used as a drying/dewaxing station.
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Only SS-30H Pay special attention to the programmes that use the drying station. In these
cases, make sure that the previous programmed step cannot originate from
a trough containing a flammable reagent (e.g. xylol). This is to prevent a
possible fire.

=) Robotic arm

Check that the robotic arm is located on the left-hand side of device and in a
raised position (starting position). If not, press F key to situate the arm in the
initial position.

Rack collection.
To check that the robotic arm is collecting the racks properly, see the
MOVEMENT procedure on page 20.

15
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Slide stainer components

The figure below shows the Slide Stainer’s different components.

Loading door
Central door
Unloading door
Robotic arm

Slide rack
(maximum 5)
Troughs (20)
Display screen and
keypad

agRrwON=

N

Display screen and keypad

UNLOAD

(= =
myreva

DRAIN

= The DRAIN key is used to enable or disable the draining of the racks as
they leave each trough. If enabled, the word DRAIN appears on the
monitoring screen.
This function can only be enabled or disabled when the Stainer is not
performing any processes.

@ The F key is used to abort all staining processes that have been started
and to situate the arm in the initial position with the equipment in standby
mode and away from the process screen.
' The LOAD key is used to confirm the steps of the loading process.
(=)
UﬂD The UNLOAD key is used to confirm the steps of the unloading process.

16
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The arrow keys are used for navigation (option selection) within the
different menus, and the middle key is used to confirm or validate the
selected option. It is equivalent to the ENTER key.

The ESC key is used to exit the various menus in which values and
operation options are entered.

Menus and options

Main menu

E]g(ﬂ

(@)

STAIN

4

m
=
|

Slide Stainer The main menu shows the four main
V XX options.
MAIN MENU

= Use the arrow keys to highlight the
(_k’) @ @ option you wish and press ENTER.

STAIN EDIT SETUP S.AT.

This is the normal operation option for performing processes. It enables
the user to select the programme to run, control loading and unloading of
the racks in the troughs and view current processes.

This allows you to enter and edit programmes with the keypad.

Remember that you can also edit programmes with a PC and then transfer
them to the Stainer via a USB.

This enables you to adjust the stainer settings, such as language, date,
speed, dip, etc.

Technical Support Service: This provides access to advanced functions
which must only be modified by authorised personnel.

17
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Configurations and settings

: Before starting the first staining process, some parameters have to be
(’) configured in the EDIT and SETUP menus.
STAIN Once the settings have been adjusted and the reagents and programmes

edited, the STAIN process can be started. See the details of how to run a
staining process on page 27.

This enables you to enter a numbered list with the reagents used.

3—,? & This list is merely informative and is used to facilitate the entering
of the names of the reagents during programme editing.
EDIT REAGENTS J 9 prog g
= Enables the entering of the reagents to be used,
::? numbered 1 to 52. See an example reagent list on
= page 22.
VIEW/
EDIT
——=  This enables you to selectively delete reagent
= ., positions.
—
DELETE
Only in SS-30H Enables each station to be assigned with a reagent
e and, optionally, its useful life in days and/or operating
MAP cycles (racks processed) to be tracked. See page 28
“| Before starting a staining process, the Stainer needs to be
provided with the sequence of steps that each rack must follow.
The Programming Forms must be previously defined. See page
PROGRAMMES ,3 = ° J P Y pad
— This enables you to enter programmes.
—» View the editing procedure in detail on page 27.
—
VIEW/
EDIT
———= This enables you to selectively delete programmes.
=9
DELETE
Some of these settings can only be configured during initial device start-up
(e.g. language, clock).
SETUP Others will only require changes if so decided by the pathologist
responsible for the procedure (reagents, dip, speed, etc.)
Also included here are the parameters that control the fume filter and
ventilation.
Each option includes a brief summary of its function.
Fa Use the arrow keys to select the language and then press ENTER.
LANGUAGE & SR=
— 1 1.

SPANISH ENGLISH

(32 Use the arrow keys to select each parameter and then press ENTER.

ey Within each option, use the arrow keys to increase or decrease the value
CLOCK andthen press ENTER to confirm.

18
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Clock edit menu
Edit date: DD/MM/YY
Edit hour: HH:MM:SS
Type: 12/24H

Dip of the rack within the trough.

The dip height, dips number and dip speed of the rack in the reagent and
washing troughs can be adjusted.

This affects the reagent stations.
It is possible to define up to 4 Dip Modes, each with separate

REAENT parameters.

With the G]@ arrows, select the Dip Mode to be defined
(01... 04).

Press ENTER to access each of the parameters and select
the value using the () and =) arrows.

The example shows the editing of Mode 01 parameters for the
reagent stations.

REAGENT S. - [MODE 01]

Dip Height (mm.) 20
Dips Number 4
Dip Speed 2

Dip Height (mm.) 10-20-30
This value determines the vertical travel of the rack during dip
within the trough. The standard value is 20 mm.

Dips Number: 1-2-3-4-5-6-7-8-9-10
This value determines the number of times the rack will be
moved during dip within the reagent trough. The standard value
is 4.

Dip speed: 1-2-3-4
Please note: value 1 is the highest speed and value 4 the
lowest. The standard value is 2.

19
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20

SPEED

WATER

©

MOVEMENT

Only in SS-30H

(1)

DRYER

& This affects the washing stations.

CLEANING With the G][E] arrows, select the Dip Mode to be defined
(01... 04).
Press ENTER to access each of the parameters and select
the value using the () and =) arrows.
The example shows the editing of Mode 01 parameters for the
washing stations.

CLEANING S. - [MODE 01]

Dip Height (mm.) 40
Dips Number 4
Dip Speed 2

Dip Height (mm.) 20-30-40-50-60
This value determines the vertical travel of the rack during dip
within the trough. The standard value is 40 mm.

Dips Number: 1-2-3-4-5-6-7-8-9-10
This value determines the number of times the rack will be
moved during dip within the reagent trough. The standard value
is 4.

Dip Speed: 1-2-3-4
Please note: value 1 is the highest speed and value 4 the
lowest. The standard value is 2.

This option enables the speed of the vertical movement of the rack to be
determined.
Speed edit menu
Lifting speed: 1-2-3-4
Lowering speed: 1-2-3-4
Please note: value 1 is the highest speed and value 4 the lowest. The

standard value is 4 for raising and 3 for lowering.
Note that the slowest elevation speeds (e.g. 3, 4) produce less reagent drag.

Water flow menu

Water valve (closed/open)
This enables you to manually open or close the solenoid valve that controls
the entry of water into the Stainer. It is used to check trough filling time and to
ensure that water flow does not exceed draining capacity. Check that the filling
time is about 13 seconds per trough.

Valve time: MM:SS
This indicates how much time has elapsed with the valve open.

Rinsing Time: 0-30-60-90
This determines how long water will continue circulating in the rinsing troughs
after the rack leaves the trough.

This option allows you to check the functioning of the robotic arm. Select
Setup > Movement.

The device requests you to place a rack in station 1 and to confirm the
placement by pressing ENTER to perform a rack collection cycle. Press
ESC to cancel the option.

If the rack is not collected properly, notify the person responsible for the
device’s maintenance.

Drying/dewaxing station menu
Status (ON/OFF)
Enables the drying station to be activated/deactivated.
Temperature
Sets the drying temperature
Celsius/Fahrenheit
Sets the temperature scale as Celsius or Fahrenheit
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Attention: Burn hazard
If you activate the drying station, be aware that high temperatures are
generated in its immediate vicinity.

Fan edit menu
&7 This option defines filter usage time and useful life, as well as fan usage
FILTER time.

@ Filter Use Time (h) 0...150
This time depends on how long the fan has been operating. It

determines the operating time in hours (with the fan running). Its
value will also depend on the reagents used and the type of filter
(see the filter supplier’s instructions).

Remaining Time (h)
This indicates the time remaining before the stainer emits a
“change filter” alarm.

Reset
This option should only be enabled after a filter change. It resets
the filter usage time.

FILTER

@ Fan On First Time (s): (0 ... 300)

This establishes how long the fan should operate each time the
device is turned on with the power switch. Once this time has
elapsed, the fan switches off and then switches back on and off in
accordance with the programmed on and off times. Normal value
120 s

Fan Off Time (s): (0 ... 900)
Normal value 300 s

Fan On Time (s): (0 ... 120)
Normal value 60 s

FAN

This option defines the codes for access to the different levels of changes
m"” in the stainer’'s parameters for 2 administrators and 4 users. (Grey icon
CODES inactive / green icon active)

T e

ADMINISTRATOR
USER1 To enable activation of a user code, an
UU USER2 administrator code needs to be created
first.
USER USER4

Loading Stations: 1-2
( Hl ) This defines the number of stations that will be assigned for the loading of racks
on the left-hand side of the Stainer. The normal value is 2.
Unloading Stations: 1-2-3
This defines the number of stations that will be assigned for the unloading of
racks on the right-hand side of the Stainer. The normal value is 2.

STATIONS

.I In this menu, the running of staining processes can be prioritised according
@ to Order of entry (order in which the racks are loaded) or Optimized Time
PRIORITY (greater quantity of samples in the shortest possible time).
The default option is Starting Order. Use the arrow keys to select the
desired option and then press ENTER to confirm.

Advanced configurations

Q, Technical Support Service
4 The options in this menu are reserved for the technical support service.

SAT.
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Programming

Multi-load mode

Preparation

List of reagents

The two most outstanding features of the MYREVA SS-30 Slide Stainer
are:
e Its ability to operate in multi-load mode.
e Its great versatility in determining operating parameters: almost all
process parameters are freely configurable.

This feature enables the Slide Stainer to perform up to 5 processes
simultaneously. This means that it is possible to start other staining
processes (up to 5) without the need to wait for processes to finish.

This feature greatly improves the performance of the Slide Stainer, enabling
it to achieve high levels of productivity.

Before using the Stainer, the following must be prepared in advance:
e The list of reagents
¢ The Reagent map(s)
e The staining programme(s)

To facilitate the entering and documenting of programmes in the Slide
Stainer, it is recommended that you create a List of Reagents to enter into
the Stainer. See page 27.

This assignment of reagents is purely for illustrative purposes.

No. |Reagent No. |Reagent No. | Reagent

01 Haematoxylin-Harris 19 Acid H20 37

02 Aqueous Eosin 20 Bluing Reagent 38

03 | Alcohalic Eosin 21 | Ammonia H20 39

04 0G-6 22 Periodic Acid Solut. 40

05 EA-36 23 Schiffs Reagent 41

06 EA-65 24 Sulphite Rinse 42

07 EA-50 25 | Van GiesonStain 43

08 Xylene 26 Alcian Blue 44

09 Xylene Substitute 27 Perls Reagent 45

10 | Alcohal 28 Leishman Stain 46

11 Methanol 29 May Grundwald Stain 47

12 Ethanol 30 Giemsa Stain 48

13 Isopropy! Alcohol 31 Wright Stain 49

14 Buffer 32 Jenner Stain 50 [Dryer]

15 Tap H20 33 51 Load (Xylene)
16 Distilled H20 34 52 Unload (Xylene)
17 Deionised H20 35

18 | Acid Alcohol 36

22
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ATTENTION!

A The MYREVA SS-30 is unable to detect the type of reagent used in each
station. Make sure that the programmed reagent corresponds to the ACTUAL
content of the station.

Preparation of programmes

Optimising the functioning of programmes in the Slide Stainer in multi-load
mode (several staining processes simultaneously) depends on several
factors:
o The order of the reagents in the troughs and having several troughs
with the same reagent.
e The position and quantity of rinsing troughs (water).
o The possibility that the staining processes to be simultaneously
performed share the same reagents.
¢ Immersion times and the duration of agitation of the rack within
each trough.
o Whether the immersion time is critical or not. Meaning that the
sample cannot be immersed for longer than specified.

This means that, at the same time as creating staining programmes to be
performed, a Reagent map should also be created to maximise the
resources, based on the points mentioned.

The example shown here is based on two simultaneous staining
programmes:

e Programme 19, TS1

e Programme 20, TS2

PROGRAMME NO.: 19 NAME: TS1

EXACT
STEP |STATION REAGENT TIME TIME DIP MODE
1 1 Load (Xylene) 00:00 NO 0
2 3 Alcohol 100 05:00 NO 1
3 4 Alcohol 96 05:00 NO 1
4 5 Alcohol 70 05:00 NO 1
5 6 Water 01:00 NO 2
6 7 Haematoxylin-Harris 05:00 YES 1
7 8 Water 01:00 NO 2
8 9 Hydrochloric acid 00:01 YES 1
9 10 Water 01:00 NO 2
10 11 Ammoniacal 00:04 YES 1
11 10 Water 01:00 NO 2
12 12 Alcohol 96 01:00 NO 1
13 13 Eosin 00:15 YES 1
14 15 Alcohol 96 01:00 NO 1
15 17 Alcohol 96 01:00 NO 1
16 18 Alcohol 100 02:00 NO 1
17 20 Unload (Xylene) 00:00 NO 0
29:20
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24

PROGRAMME NO.:20 NAME: TS2
EXACT
STEP |STATION REAGENT TIME TIME DIP MODE
1 2 Load 00:00 NO 0
2 4 Alcohol 96 05:00 NO 1
3 6 Water 00:10 NO 2
4 7 Haematoxylin-Harris 05:00 YES 1
5 8 Water 01:00 NO 2
6 9 Hydrochloric acid 00:01 YES 1
7 10 Water 01:00 NO 2
8 11 Ammoniacal 00:01 YES 1
9 10 Water 01:00 NO 2
10 12 Alcohol 96 02:00 NO 1
11 14 Orange 03:00 YES 1
12 15 Alcohol 96 02:00 NO 1
13 16 EA-50 03:00 YES 1
14 17 Alcohol 96 02:00 NO 1
15 18 Alcohol 100 02:00 NO 1
16 19 Unload (Xylene) 00:00 NO 0
27:12

PROGRAMME NO.
(1...20)

NAME
(ABC)

STEP
(1...50)

STATION
(1...20)

REAGENT
(Name)

©

TIME
(MM:SS)

The meanings of the different fields are shown below:

The Slide Stainer's memory has capacity for up to 20 different processing
programmes. Each programme must have a number from 01 to 20.

Each programme can have a three-digit identification name as a reminder of
its function.

This column is simply a sequence of numbers to indicate the order in which
the steps are executed. The programme allows up to 50 steps and there
should not be any empty steps.

This refers to the station or trough number (1 to 20) in which each stage of
the process is performed.

This indicates the reagent contained in the corresponding trough in each
station determined by the Reagent map.

The troughs that contain water have been defined during installation and
cannot be freely configured (see page 12). When a water trough is selected,
it should always be assigned reagent number 15.

This is the time in minutes and seconds that the sample remains immersed
in the trough. 00:00 indicates an indeterminate time (for example, for the
loading and unloading troughs).



EXACT TIME
(YES - NO - 50%)

i

DIP MODE
(0-1-2-3-4)

i

Slide Stainer

This indicates whether the assigned immersion time is critical or not, that

is, whether it should be accurate (accuracy +/- 1 second).

YES means that the sample may be damaged if it remains for a longer time
than that indicated. This time will not be exceeded under any
circumstances by the stainer.

50% means that the sample can remain immersed for a maximum of up to
50% more than the time specified without becoming altered.

NO means that the sample can remain immersed for a maximum of up to
100% more than the time specified without becoming altered.

In anticipation of optimum multi-load utilisation (5 simultaneous processes),
it is not advisable to use the ‘YES’ option indiscriminately, but reserve it
exclusively for very critical immersion times. Failure to follow this
recommendation may lead to situations that hinder optimum multi-load
operation.

This column indicates the Dip Mode to be used.
0 No dip

1 Dip mode 1

2 Dip mode 2

3 Dip mode 3

4 Dip mode 4

The Dip modes, which refer to the dip amplitude, the number of dips and
the dip cycle time, can be independently configured for the reagent and
water troughs (see page 19).

Note that a determining factor in the amount of time that the arm will remain
occupied (agitating the rack) is also the number of dips defined in Setup >
Dip > Reagent/Cleaning (see page 19). The amount of time that the rack
remains in the trough takes precedence over the time resulting from the dip
mode (speed x number of dips). This means that the rack can be removed
from the trough without having completed the number of programmed dips.

Page 52 features a blank programming form that can be photocopied.
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Reagent map

REAGENT MAP (Example)
REAGENT Programme
STATION REAGENT NO. Ts1 TS2
1 Load (Xylene) 51 TS1
2 Load (Xylene) 51 TS2
3 Alcohol 100° 33 TS1
4 Alcohol 96° 34 TS1 TS2
5 Alcohol 70° 35 TS1
6 Water 15 TS1 TS2
7 Haematoxylin-Harris 1 TS1 TS2
8 Water 15 TS1 TS2
9 Hydrochloric acid 36 TS1 TS2
10 Water 15 TS1 TS2
11 Ammoniacal 37 TS1 TS2
12 Alcohol 96° 34 TS1 TS2
13 Eosin 38 TS1
14 Orange 39 TS2
15 Alcohol 96° 34 TS1 32
16 EA-50 7 TS2
17 Alcohol 96° 34 TS1 TS2
18 Alcohol 100° 33 TS1 TS2
19 Unload (Xylene) 52 TS2
20 Unload (Xylene) 52 TS1

26

This Reagent map example shows the reagent that each trough should
contain to perform programmes TS1 and TS2, the reagent number (to
facilitate its inclusion when entering the programme into the stainer) and the
programme that each trough uses (TS1 or TS2), thus clearly demonstrating
the troughs shared by both programmes.

The Reagent map is closely related to the programming forms and will be a
characteristic of each laboratory. Different Reagent maps can, of course, be
defined to be used with different programmes.

Remember that the reagent contained in each trough must be entered into
the MAP. See page 28

It is the responsibility of the user to ensure that each trough contains the
reagent shown in the MAP.

Page 53 features a blank reagent map template, which can be photocopied.
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Reagent and programme editing

[0}

= ( 0 |

-

The reagent and programme edit menu enables you to enter the information
required for the operation of the stainer.

From the main menu, using the arrow keys, select EDIT and press ENTER
to confirm.

EDIT MENU

¢ [

REAGENTS PROGRAMS

Remember that it is also possible to edit the reagents and programmes with
a PC and transfer them to the Slide Stainer via USB. See page 31.

Editing reagents list

G]@ @ Using the arrow keys, select REAGENTS and press ENTER to confirm.
s

0

|

?

)
®)
©

Using the arrow keys, select EDIT and press ENTER to confirm.

01 Haematoxylin The numbering is fixed.

02 AqueousEosin Using the arrows, select the name of the
03 AlcoholicEosin reagent that you wish to assign to each
04 OG-6 number and press ENTER to edit it.

05 EA-36

06 EA-65

Note that the number and name of the assigned reagent is for information
purposes only. The correspondence between the stations and the
reagents contained within them is determined by the MAP. See page 28

The following figure shows the appearance of the edit screen.

Alcoholic Eosin
q w e r t y u i o P
a s d f g h j k I
A z X © v b n m Del
123 , : Ent

Navigate around the virtual Qwerty keyboard to select the letters, numbers
or symbols that you wish to insert and then press ENTER.

On the virtual Qwerty keyboard, use “*” to select upper and lower case, “123”
to access the numerical keypad and “Del” to delete incorrect entries.
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0

RMS

Once the reagent name has been edited, select “Ent” and then press ENTER
to finish editing.

A confirmation message will appear.

Press ENTER again to confirm the changes.
Press ESC to leave the edit menu without
saving changes.

Save changes?

YES Enter NO Esc

To delete a reagent, use the same procedure but, this time, select DELETE.
A confirmation message will also appear.

The MAP icon enables the Reagent map to be entered into the slide
stainer.

Each station must be assigned with its corresponding reagent in the
Reagent column. By pressing ENTER in each cell, a window will appear to
enable you to select the reagent corresponding to the station using the
vertical scroll arrows. Press ENTER again on the selected reagent to assign
it to the station.

01
02
03
04
05

The Reagent Management System (RMS) enables you to keep track of the
depletion or expiry of the reagents used.

To edit the RMS, select the RMS field and press ENTER. Use the arrows
to move around the screen and set a maximum number of days, racks or
both values.

Reset | | Resetal |

01 — I-- [-- T--

02 — |- |- [|--

03 — 1-- [-- T--

04 — |- |- [|--

05 — - [-- T--

When either of the two maximum values is reached, an alarm will sound to
indicate that the reagent needs to be replaced.
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After replacing the reagent, navigate to Reset in the top row of options
using the vertical and horizontal arrows.

Press ENTER to select this option, go to the Changed column of the
corresponding station and press ENTER to update the change date.
Press ENTER again to confirm the
changes.

Press ESC to exit without saving changes.

Update change date?

0

ESC YES Enter NO Esc

!

The Reset all option enables you to delete all of the information from the
day and rack counters.

Press ENTER again to confirm the
changes.
Press ESC to exit without saving changes.

Reset counter?

0

ESC YES Enter NO Esc

!
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Entering programmes

(O ()

(0}

(@)

m

i

Il
X

DELETE

The programmes that were previously determined on the programming form
can be entered into the Stainer by means of the display screen and keypad,
or a PC connected via a USB (page 31)

To enter them with the keypad, perform the following steps.

Using the arrow keys, select PROGRAMMES and press ENTER to confirm.

Using the arrow keys, select EDIT and press ENTER to confirm.

N PROGRAMME:

NAME: H&E
01 01 00:00 | No 0
02 03 | Alcohol 100 05:00 | No 1
03 04 [ Alcohol 96 05:00 | No 1
04 05 | Alcohol 70 05:00 | No 1
05 06 [TapH20 ] 01:00 | No 2

Using the horizontal arrows keys, select the programme number to edit
(01... 20).

Press the down arrow key to access the programme name. If you wish to
modify it, press ENTER to access the virtual Qwerty keyboard.

Press the down arrow again to access the programme edit fields.

Use the arrow keys to navigate to the field that you wish to edit (highlighted
in BLUE) and press ENTER. The background colour of the field that you are
about to edit changes to RED. Use the vertical arrow keys to change the
value of the field and press ENTER again. The field returns to being
highlighted in BLUE.

Note that, in the Reagent field, you must enter the same reagent that has
been set for each station in the MAP.Otherwise, an error message will
appear indicating that there are discrepancies between the Programme
and the MAP.

To delete a programme, select DELETE.
A list of programmes entered into the Stainer will appear.

01 H&S Using the arrow keys, select the
02 PAP programme you wish to delete and press
03 PST ENTER.
04 NOP A confirmation message will appear.
05 NOP
06 NOP

Press ENTER to confirm the deletion of the

Save changes? programme.

Press ESC to cancel the deletion of the

YES Enter  NO Esc programme.
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Remember that all programmes must always have a first step 1 (LOAD) and
a last step (UNLOAD).

Programming with PC

Stainer Software is a programme designed to facilitate the programming of
the SS-30 slide stainer and collect data on staining processes that have
been performed.

The software enables programmes and settings to be backed up, edited,
viewed, modified and printed.

Connecting the equipment

Minimum PC requirements:

PC compatible with Windows XP or higher
1 free USB port

CD-ROM

Java 6 or higher

USB AM/BM cable (printer type).

W

/ Ty
T

Connect the supplied USB cable to the slide stainer and PC. Turn on the
slide stainer and PC. There may be a slight delay the first time as the
necessary drivers need to be installed

Installing the programme

Close all applications that are running before installing SLIDE STAINER
SOFTWARE. Insert the CD-ROM into the PC, find and run the file
‘StainerSoftware2.0-setup.exe’ and follow the installation instructions.

Running the software

The installation programme creates a desktop shortcut.

(s

Double-click the icon to start the programme. The following start screen
appears:
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w

Pragrams Reagents Map Info Settings

HNumber 1
HName ROP

Slep
1

3

4

5

6

7

B

9
10
1
12
13
4
15
16
17
18
19
20

A row Delele row

Desconnecicd

Stainer Software g

Logs History

Station Reagent Time [mm:ss] Exact Time Dip Mode

Delele program

Configuration

Programs

HNumber 1

Name

Slep

O o Tr Oy B G2

A row

Disconnecied

Firstly, select the COM port to which the equipment is connected. To do so,
use the “Connect > Via USB” menu:

Stainer Software g

Reagents Map Info Settings Logs History

Station Reagent Time [mmss] Exact Time Dip Mode

‘Connect

Select serial poa.

COMa “

Aceptar | | Cancelae

Ouhete row Delele program

In the dialogue box that appears, select the appropriate port.

After selecting the port, determine the working directory with the “Edit >
Working Directory” option. In the browser window that appears, select the

directory in which the programmes and data files generated by the software
will be saved.
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File |Edit| Connect Help
tings
Workspace
Number 1
Name: |NOP

Step Station

NP

Slide Stainer

Add row Delete row Delete program

Connected

Stainer Software - o IEHN
MYR Reagents Map Info Settings Logs History
< Back Next >
Reagent Time [mm:ss] Exact Time Dip Mode
B Set Ex|
Buscar en: Myr v e m-
1 Jssc ! & Mis videos
e b ‘mplabcomm # Vinculos
Elemento... . oracle_jre_usage
Application Data
! i Blsquedas
Escritorio | 2 Contactos
& Descargas
Bl Escritorio
F i Favoritos
MiS docls. # Juegos guardados
A d Mi masica
5 ~| Mis documentos
Equipo = Mis imagenes
- e
Q—‘! Nombre de carpeta:  |C:\Users\Myr Set
Red Archivos de tipo- Todos los Archivos v Cancelar

File menu

New

Open

Save

Read

Write

Write Flash

The software automatically generates two files every day: a file with the
extension “.csv” in which all staining processes performedduring the day
are saved and a file with the extension “.log” which contains any errors and
alarms logged by the equipment.

The File menu features the following options:

This initialises all programmes and tables, and shows the settings with the
default values

This opens a file with the extension .myr containing programmes, reagents
and settings.

This saves programmes, reagents and settings in a file with the extension
.myr

This reads the machine’s programmes, reagents and settings. (Active only
in Connected mode).

This writes the machine’s programmes, reagents and settings. (Active only
in Connected mode).

After a confirmation message, this writes the programmes, reagents and

settings that are already in the machine’s flash memory. (Active only in
Connected mode).

33



Slide Stainer

Print This prints programmes, settings, info and logs

Quit This closes the programme.

Creating a programme

Bl

Stainer Software - o lEN
File Edit Connect Help

Programs Reagents Map Info settings Logs History

Number 1
Name NOP

tep Station Reagent

- 0

[Perls Reagent
Leisnman Stain
May Grunwald Stain
[Giemsa Stain
lenner Stain
Load

30 Unioad

1"

12

13

14

15

16

17

18

19
|20

mmumuauI
z
g
o

Add row Delete row Deete program

Connected

From the Programs tab, it is possible to create or modify programmes.
The fields need to be filled in by selecting the options in the dropdown

menus (Station, Reagent, Time, Exact Time and Dip Mode), as specified
for each process.

At the bottom of the screen, there are three buttons with the following
functions:

Add Row This adds an empty row at the end of the table up to a maximum of 50 rows.
Delete Row This deletes the selected row from the table down to a minimum of 3 rows.

Delete Programme This initialises the programme and establishes the 20 default rows.

ATTENTION:

As each station has a reagent already assigned (see MAP on page 28),
when programming each station, the same reagent as indicated in the MAP
must be entered.

Otherwise, an inconsistency error will appear during the running of the
programme.

The programme’s reagent(s) does
not match the configuration
Continue?

YES Enter NO Esc

Press ENTER to accept the inconsistency and continue.

Press ESC to interrupt the running of the programme and resolve the
inconsistency.
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Reading and writing programmes

£

To read the slide stainer's programmes when it is connected to the PC,
select the option “File > Read...”.

File| Edit Connect Help

New
Open
Save.
Read
Wiite:

Print.
Quit

3
4
5
6
7

9

10
1
12
13
14
15
16
17
18
19
20

e Flash

Cer+ N

c+0 lgents Map Info settings Logs History

Ctrl+S

Ctri+R

CrsW < Back Next >
ek

— Station Reagent Time {mm'ss] Exact Time Dip Mode

culQ d w2 2

Add row

Connected

Delete row Delete program

In the popup window that appears, select what is going to be read.
(Programmes and reagents are always associated).

Read

Select tabs to read:

[IPrograms

[1Reagents

[IMap

[[] Settings

[T History
MYR

Aceptar ! Cancelar

By clicking OK, all data received from the slide stainer appears on screen.
At this point, it is possible to generate a backup file with the extension “.myr”

and save it in the “File > Save...” menu so that it can be recovered at a later
date if necessary.

The writing process is quite similar. Once a new programme has been
created, modified or recovered from a previous file, and with the slide
stainer connected to the PC, select “File > Write...”. In the popup window,
select what you want to write and confirm by clicking OK.
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o Stainer Software -9a “
_Fne Edit Connect Help
New Crd+N
Open... Cris0 Igents Map Info Settings Logs History
Save Ctri+§
Read Ctrl=R
Write. Curl+W < Back Next >
rite Flash. Chrl+F
Print CileP Station Reagenl Time [mm: SS] Exact Time Dip Mode
Quit ey 1 ] 0000 No 0
= 2 03.00 No 2
3 3 Xylene 03.00 No 2
4 4 Xylene 03.00 No 2
5 5 Alcohol 01:30 No 2
6 6 Alcohol 01:30 No 2
7 Z: Alcohol 01:30 No 2
8 9 Tap H20 01:30 No o
9 12 Periodic Acid Solut 06:00 No 2
10 10 Tap H20 01:00 No o
1 13 Schiffs Reagent 0300 No o
12 9 Tap H20 05.00 No o
13 8 Haematoxylin 07:00 50% 2
14 1 Tap H20 09:00 No 0
15 14 Alcohol 01:30 No 2
16 15 Alcohol 01:30 No 2
17 16 Alcohol 01:30 No 2
18 17 Alcohol 01:30 No 2
19 18 Xylene 01:30 No 2
20 19 Xylene 01:30 No 0
21 20 1| 00:00 No 0
Add row Delete row Delete program
Connected
Once writing is complete, everything transmitted will appear in the slide
stainer. This first writing is temporarily stored in the volatile memory of the
equipment to enable the user to check that it is correct. This means that if
the slide stainer is turned off and then on, the stored information will be lost.
To confirm the writing and definitively save it in the slide stainer, it needs to
be written again with “File > Write Flash...”.
@ Stainer Software - o IEN
"Fwe Edit Connect Help
New Crrl+N
Open Cil-0 igents Map info Settings Logs History
Save Cerl+§
Read Ctri«R
Write: Cerlew < Back Next >
Write Flash.._ Ctri+F
Print P Station Reagent Time [mm ss] Exact Time Dip Mode
Quit cul i B e o o
z 2 03.00 No 2
3 3 Xylene 03:00 No 2
4 4 Xylene 03.00 No 2
5 5 Alcohol 01:30 No 2
6 6 Alcohol 01:30 No 2
7 7 Alcohol 01:30 No 2
8 9 Tap H20 01:30 No 0
9 12 Periodic Acid Solut 06:00 No 2
10 10 Tap H20 01:00 No 0
11 13 Schiffs Reagent 03:00 No o
12 9 Tap H2C 0500 No L]
13 8 Haematoxylin 07.00 50% 2
14 1 ap H2Q 09:00 No o
15 14 Alcohol 01:30 No 2
16 15 Alcohol 01:30 No 2
17 16 Alcohol 01:30 No 2
18 17 Alcohol 01:30 No 2
19 18 Xylene 01:30 No 2
20 19 Xylene 01:30 No 0
Al 20 nioad 00:00 No 0
Add row Delete row Delete program
Connected

And, in the popup window, confirm the writing in the Flash memory.
Write Flash

Select tabs to write:

Programs
Reagents
[ Map
Settings
v MYR

| Aceptar | Cancelar
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Write Flash

Are you sure you want to write to flash?

i Mo

Once confirmed, it remains stored even if the slide stainer is turned off.

Reading and writing reagents

32 default reagents appear in the programme, and these are the same as
those that appear in the machine. All reagents can be edited, except
number 15, which, as previously mentioned, is reserved to indicate the
washing stations.

The functioning of the reading / writing is exactly the same as that for
programmes.

Remember that the reagents are always linked to the troughs.

(£ Stainer Software - ol
File Edit Connect Help

Frograms Reagents Map Info Settings Logs History

01 Haematawylin
02 Aquedus Eosin
03 Alcoholic Eosin
04 0G6

05 EA-36

06 EA-G5

07 EA-50

08 Xyhene

09 Xylene Substitute
10 Alcohol

11 Methanol

13 Isopropyl Al ohol
14 Bulter

16 Distited H20

17 Delonised HAO

18 Acid Akohal

19 Acid H20

20 Blumg Reagent

21 Ammonia H20

22 Penodic ACk Solut.

Connected

At the end of the list, two buttons, “Refresh” and “Reset”, appear with the
following functions:

Refresh This updates the list of reagents in the dropdown menu of the “Programs”
tab.

Reset This initialises the list of reagents to the 32 default reagents.
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Tabs “Info, Settings and Logs”

Info This tab enables the user to view processes running in real time

File Edit Connect Help

Programs Reagents Map Inta settings Logs History
2 3 4 5

User
Humber 19 2 2 3
Program | 151 152 157 KLF
| Rack 10 " 12 13
| LoadTime |1z4282 124321 124510 13.02 25
| StartTime | 124252 13.01:10 13.01:47
ft_| 00-00.00 001749 0013:37
T | 003246 0053 43 0002 01

T | 000000 00,00 00 00.00 00
[TStep2prog T | 000500 00.05.00 00.00.10
| “Step 2 Reai T 05.01 1 :

TmepaProg T | 000500 00.00:10 00.00.10
[Step 3 RealT | 00.0501

Step 4 Prog T | 00.05:00 00:00:10

i PR : :

_| 00100 00:01°00 00:00:10

| SepBProgT | 00.00.00
[ Step & Rea T ;
[ StepTProgT | 00.01.00 000100
[“Step 7 Reai T
| Skep8ProgT
Step & Real T i

Connected
Each rack is shown in a column, indicating:

Programme no.

Programme name

Loading time

Programme start time

Difference between the loading and start time
Total time estimated by the equipment

Actual total duration of the programme

Difference between the estimated and actual time
Programmed time in each step

Actual time that the rack remains in each step

The colour codes for the times are as follows:

Black: Programmed times.

Pink:  Time programmed as critical.

Green: Time correctly completed.

Red: Programmed time exceeded.

Blue: Time at which the rack enters the trough (the trough in which it
is situated at that moment changes when it comes out).
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Settings This tab lists all of the machine’s programmable settings

- Stainer Software - 8
Frograms Reagents Map Info Settings Logs History
Date & Time 160372016 12:35:01 ’
Language English -
Clock 24h v
Lifting Speed 4 v
Lowering Speed 3w
Rinsing Time: (s) &0 [0-80]
Fan On First Time (5) 120 [0-300]
Fan Off Time (5) 300 [0-900]
Fan On Time (5) 60 [o-120]
Loading Stations 2 v
\Jnkmmngs!almng 2 v
Prionity Optimized tme v
Reagent 5. Dip Mede 1 Dip Mede 2 Dip Mode 3 Dip Mode 4
Dip Height (mm) 20 - 0 v 20 ~ 20 ~
Dips Number 4 4 4 rl [1-10]
Dip Speed Y FY 2 v 2w
Cleaning 5. Dip Mode 1 Dip Mode 2 Dip Mode 3 Dip Mode 4
Dip Height (mm) 40 ~ 40 * 40 ~ 40 v
Dips Number 4 4 4 4 [1-10]
Dip Speed 2 v 2 v 2 v 2 v )
Connecled
From here, it is possible to modify/read/save all of these settings.
The date and time are synchronised with the PC when it is connected to
the slide stainer.
Logs In this tab, all alarms that have appeared in the equipment are logged.
“History” tab (Only SS-30H)

This tab allows you to view and save to your computer all historical data
accumulated by the slide stainer since the last reset.

You firstly need to download the slide stainer’s historical data to your
computer. To do so, mark the “History” tickbox in the “File > Read” menu
(see page 33).

Select tabs to read:

[1map

[ settings
q History
MYR

Aceptar Cancelar
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When you click the “History” tab, the following screen will appear:

File Edit Connect Help

Programs Reagents Map Into | settings | Logs History
Fierby | User v Expart Save Load

d User Program Rack Start Time End Time: Aarms

1 o user TSt & 201603116 1220:08 20160316 123101 o

2 Mo user T8 7 20160316 12.31:01 1

3 Mo user TS1 10 2016103/16 124252 2016/0316 131613 0

4 o user 152 1 0160316 130110 1

5 o user ST 12 AGOI6 130147 20160016 130347 o

& No user KLF 13 PO160316 130347 1

Connected

The first column, “Id”, shows a consecutive numbering of the events
produced. The following columns provide more information about each
event.
Filter by: This option allows you to filter data by User, Programme, Rack, etc.
Export Enables you to export the data shown on screen in “.csv” format for

subsequent processing.

Save Saves the data in a “.h2.db” format file for subsequent viewing.

Load Loads the data from a previously saved file.
To view further information about a particular event, click the
corresponding row.
In this example, the event Id=4 has been selected (No user, Program TS2,
Rack 11).

User Ho user Start Time 20160316 1301 10 Drain YES
Program 182 End Time Dryer: o
Rack 1 Calcutated Time 003343 Temperature ("C). 65
Lifing Speed: 4 Loading Stations; 2 Pre-time (s} o e =
Lowering Speed. 3 Unloading Stations. 3 | Eport | | Print
Step Station Reagent Time Exact Time Real Time Dip Mode Stan Time End Time Days Max Days Racks Max Racks
11 Load 00.00 Ho 00:01 L' 130125 130126 o o o o
_2 4 Alcohol 06 0814 No 08:18 1 13.01:36 13:00.56 o o L] 0
3 L] Tap H2O 0015 Mo 00:15 2 131008 131023 0 0 [} 0
4 7 Hasmatcoylin 0500 Yes 0501 1 1310:35 131536 1] '] o o
5 8 Tap H20 01:00 No 0101 2 131548 131649 o 1] 0 o
I L] Clorhidrico 00.01 Yes 0001 1 131701 131702 o 1] o o
LT 10 Tap H20 0.0 No 0100 2 131794 13184 o ] o o
1] 1 Amonacal om Yes e 1 13asar sz o o 0 0
2 10 Tap H20 01:00 Ho o0 2 131839 1319:40 o o o o
|10 12 AONhO! 96 0200 HO 0200 1 1319563 132153 0 0 0 o
11 14 Orange 03:00 Yes 1 13:2205 0 0 0 0

This magnified screen shows all of the details of the event.
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Print

Slide Stainer

Enables you to export the data shown on screen in “.csv’ format for
subsequent processing.

Prints the data displayed on the screen to a local or remote printer
connected to the computer.

Deleting the “History” (Only SS-30H)

i

Delete

LOAD UNLOAD

(=) + (=)

Important
Historical data is stored in the slide stainer's memory

Make sure you read the history and save the data to your computer before
deleting the slide stainer’s historical data.

To delete the slide stainer’s historical data:

Turn off the slide stainer's main switch (see page 11).
Hold down the “Load” and “Unload” keys at the same time.

Turn on the slide stainer’s main switch.
Release the “Load” and “Unload” keys.

W b=

Historical data is stored in the slide stainer for approximately 30 days,
depending on the number of hours of operation and programmes run.

When the slide stainer’s historical data memory is full, the oldest data is
overwritten.
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Running a process

42
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On page 13, it is recommended that you perform some assays without
samples or reagents to familiarise yourself with the device. Perform the
checks that are shown, carry out some test processes to verify the
programmes before filling the troughs with reagents and run processes
with real specimens.

For the tests, you can use programmes with non-critical times of 01:00 (one
minute) per stage, respecting the critical times, e.g. 00:01 for the troughs that
contain hydrochloric acid or ammoniacal. This will help you to familiarise
yourself in a little over 10 minutes with processes that in reality take more
than 30 minutes.

Loading procedure

ESC

@@(a)g

DRAIN

0

DROIC

Press ESC to return to the main menu.

Using the arrow keys, select the STAIN option and press ENTER to confirm.
The monitoring screen appears showing the status of the staining
programmes.

[1]2]3[4]|5[6]|7[8]9[10[11{12[13][14[15]16[17]18[19]20]

00:00:00
R1 R2 R3 R4 R5

If no process is in progress, you can choose to enable/disable the drain
function by pressing DRAIN. The screen will show the word DRAIN as
shown on page 45.

Press ENTER again. A screen appears with a list of programmes previously
entered into the stainer.

01 H&E Select the name/number of the
02 PAP programme that you wish to run and
03 PST press ENTER to confirm.

04 NOP
05 NOP
06 NOP
07 NOP
08 NOP




> o

The indicator light on the
loading side blinks

N
— G -
2N

LOAD flashes »

LOAD

0

Red pilot light

Green pilot light

©

Slide Stainer

These instructions must be followed carefully since the processor can
only obtain its information if the key presses confirming the loading
and unloading operations performed are made in the correct order.

For your safety, do not lift the loading or unloading doors when the
indicator light is RED. Wait for the light to turn GREEN before lifting the
door and placing the rack in the trough.

Once the programme number has been confirmed, the instruction LOAD
flashes on the screen and the indicator light on the loading side blinks
GREEN.

[1]2]3[4]|5[6]|7[8]9][10]11[12]13]14|15]16[17]18[19]20]
00:00:00

R1 R2 R3
PAP

E1

LOAD

Press the LOAD key

A\

When the GREEN indicator light stops blinking, open the loading door and
place the rack in the trough (station) indicated by the screen.
S1 and S2 refer to Stations 1 and 2 respectively.

If the indicator light is iluminated RED, wait before you lift the
door to load the rack.

The Stainer may suggest that you use a different trough to the one
programmed in order to optimise the processing time.

This message only appears when two loading troughs have been
programmed.

You can accept the newly-suggested trough if both loading troughs contain
the same reagent.
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Make sure that the rack fits perfectly into the notches of the trough,
otherwise the robotic arm will not collect it properly and a collision will occur.

LOAD

Once the rack has been placed into the corresponding trough, close the
(=) loading door and press LOAD again to confirm that the loading operation
has been completed.

The GREEN indicator light goes out and the LOAD message disappears.
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Monitoring the process

DRAIN

The screen shows an example of how monitoring of the processes is
displayed in the Slide Stainer.

This example shows 3 staining processes in multi-load mode.

R3 R2R1
[1]2]314]5]6l7]|8]9]10]11]12]13][14]15|16[17[18]19]20|
00:11:58 00:20:04 00:23:15

R1 R2 R3 R4 R5
H&E PAP PST
E6 ES5 E3 I

DRAIN

At the top, the current time and date are displayed.
R1, R2, R3, R4 and R5 are the rack numbers.

The line of squares (1 to 20) indicate the stations:

Green: Loading station

Yellow: Unloading station

Red: Drying station (only SS-30H)

Highlighted squares: Stations containing racks. The rack number is

displayed above. In the example, R3, R2 and R1.

The status of each of the 5 racks is displayed:

Top: Time remaining to complete the process in HH:MM:SS.
H&E, PAP, PST: Programmes that are running in each rack.
S6, S5, S3: Station where the rack is located. The colour of the box in the

lower left-hand corner shows the contents of the tray in the
corresponding station:

Green: Loading station

Blue: Station with water trough
Pink: Station with reagent trough
Yellow: Unloading station

Red: Drying station (only SS-30H)

The blue rectangular boxes on the right indicate the percentage of the process
completed. In the example, rack 1 is at 60%, rack 2 at 50% and rack 3 at 40%
of the processing time.

The DRAIN box is enabled/disabled with the DRAIN key and indicates the
state of activation of the draining operation when the arm has lifted the rack
from the station.

The enabling/disabling of this option is only possible when no staining
process is underway.

In the SS-30H, the status of the drying station appears here (if previously
activated):
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SS-30H

R3 R2R1
11213145 678 o 10[11][12][13][14]15]16]17]18]19]E0N

Display differences compared to the SS-30 slide stainer:

e The first box of the group in the middle indicates the actual
temperature of the drying station (43 in the example).

e The second box indicates the temperature scale used (C/F)

e The third box, marked with an F, indicates that the heater fan is
operating.

e The fourth box, marked C with a red background, indicates that the
heater’s resistors are activated.

e Station 20 is shown in red.

Unloading procedure

On completion of a rack staining process, the device beeps intermittently and
the indicator light on the unloading side blinks GREEN.

The indicator light on the
unloading \sid7 bl}nks 10:44:14 23/05/14
N ~
—@ - | [1]2]3]4]5]6]7[8]9]10[11][12]13[14][15]16[17[18]19]20]
B A 00:00:00
R1 R2 R3 R4 R5
H&E
E20
UNLOAD flashes » UNLOAD

In the example, rack R1, which is located in station S20, has completed
100% of the process and requires unloading.
The UNLOAD message flashes.

" Press the UNLOAD key.

(=)

Red pilot light If the indicator light is illuminated RED, wait before you lift the
door to unload the rack.

Green pilot light When the GREEN indicator light stops blinking, open the unloading door and
remove the rack from the trough (station) indicated by the screen.
S18, S19 and S20 refer to stations 18, 19 and 20 respectively.

M%7 Once the rack has been removed from the corresponding trough, close the

unloading door and press the UNLOAD key again to confirm that the
unloading operation has been performed, otherwise the device will freeze
and emit an error message.
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The GREEN indicator light goes out and the UNLOAD message disappears.

Alarm and attention messages

Time exceeded in
Rack XX St. XX

Program abort?

Low battery

Communication Error

Station X Load?

Unload and Enter

Mechanical Error

Valve Security Stop

Valve Emergency Stop

Filter time expired

Drying station

Here is a list of the alarm and attention messages that can appear during the
staining process.

This indicates that the immersion time (programmed + extra) of the rack (1 ...
5) and in the trough (1 ... 20) has been exceeded. The message disappears
by pressing the ENTER key. This can occur when the unloading troughs are
full and more staining processes are in progress and awaiting completion.
Check the immersion time assigned in the programme.

F

This confirmation message appears after pressing the (=) key to interrupt
a staining process. Press ENTER to confirm or ESC to cancel.

This indicates that the battery level is lower than 20% of its full charge. Turn
off the instrument with the power switch and complete the staining process
manually.

Turn on the device and check that it has power. If, even after restoring the
main power, the message remains, contact your technical support service.

This message may appear if there is no internal communication between the
slide stainer's control circuits. Restart the slide stainer to restore
communication. Contact your distributor for technical support.

This message appears when the stainer detects that loading to a different
station to that which has been programmed (1 or 2) would better optimise the
time.

This message only appears when two loading troughs have been
programmed.

You can accept the newly-suggested trough if both loading troughs contain
the same reagent.

This appears when the unloading troughs are full and another process is
awaiting unloading. Unload the racks to release the unloading trough(s) and
press ENTER to continue the current process.

This appears when a mechanical problem is detected. Find the problem and
try to solve it. If you cannot solve the problem, inform your technical support
service.

This appears when the safety sensor detects an excess of water due to a
blockage in the drain. The message disappears when the problem has been
solved.

This appears when the safety sensor in the bottom tray detects the presence
of liquid due to trough overfilling or overturning, or a problem with the water
supply. The message disappears when the problem has been solved.

This appears when the machine is switched on and every day at 12:00 when
the useful life of the activated carbon filter has expired. The message
disappears when the filter has been replaced and the filter usage time reset.
(See p. 21)

Sensor error
Fan error
Resitance error

47



Slide Stainer

48

Battery operation

A\

SS-30H

90%

The MYREVA SS-30 Slide Stainer is equipped with a backup battery in case
a power failure occurs during operation.

Only batteries approved by the manufacturer are permitted to be used. The
use of batteries not approved by the manufacturer renders the warranty
invalid.

In the event of a power failure, the illumination of the window located on the
lower left-hand side with the Myr logo will go out. The device will continue to
operate for a period of about two hours.

If you use the $S-30H slide stainer with the drying station activated, note
that the heating system is switched off during battery operation due to its
high energy consumption.

At the bottom of the display screen, a battery symbol will appear indicating
its charge percentage.

In the event of a power failure, we recommend waiting for an hour before
starting new staining processes.

If you anticipate that the power failure will be prolonged, we recommend that
you terminate all processes, turn off the device with the power switch and
replace the protective covers to prevent reagent evaporation.

When the power supply is restored, the Stainer will return to normal operation
and the battery will automatically start charging.



Maintenance

Routine maintenance

Cleaning

A\

i
i

i

Slide Stainer

To secure optimum performance of the instrument, it is recommended that
a routine maintenance be performed by a trained service technician once a

year.

It is highly recommended to replace the troughs every 2 years of standard

use.

DANGER

In the event of a major spillage of reagents, switch off and disconnect the unit
from the mains supply immediately and dry it carefully. Before starting again,
check that no parts of the robotic arm have been in contact with the spilled
fluid. In case of doubt, have the unit checked by a service engineer before
further use.

CAUTION
Only the listed reagents (see page 22) are suitable for use in the Slide
Stainer.

The use of any other reagent will be the responsibility of the user.

Reagents are to be disposed according to the lab specifications.
Solvents (reagents) that have been spilled over the instrument should
be cleaned immediately. Otherwise, the surface may be affected.
Coated surfaces and display area are resistant neither to xylol nor to
acetone.

Do not use alcohol, cleaning agents containing alcohol (i. e. glass
cleaners), abrasives and solvents with acetone or xylol to clean the
unit.

Hood, display and housing should be cleaned with conventional mild
cleaning agents.

When using cleaning agents, the security advices of the manufacturer
and the security regulations of the country where the instrument is
operated should be observed.

When operating or cleaning the instrument, no liquid should contact
the electrical connections or the inner part of the instrument.

Please observe these instructions when cleaning the instrument:

Switch off and unplug the unit from the main power before cleaning.
Open the fumehood and remove all reagents troughs.

Pour and clean them.

Reagents and water troughs may be cleaned in the dishwashing
machine.
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Wash the reagent troughs and water trough in the dishwashing machine at
max. +65 °C.
Standard washing agents can be used.

e The stations should never be washed at higher temperatures (i.e.,
using industrial dishwashing machines that work at +85 °C) to avoid
deformations.

e The hood and the coated pieces of the housing should be cleaned
with a mild cleaning agent.

e Check for the presence of dirt in the drain hose and clean it regularly.

Replacing the filter
@ When the display screen shows the following message:

[ Filter time expired |

It is necessary to replace the filter and reset the Programed Time (see page
21).

The grill that covers the filter is
attached with magnets. Pull it away
from the magnets by the handles.

Remove the filter by pulling on the
two tabs in the bottom corners.

Replace the filter with a new one and

discard the used filter following the
laboratory’s established rules.

Do not throw the filter out with the rubbish!
It contains toxic and flammable products that must be disposed of properly.

It is essential to replace the filter at the end of its useful life because, as well
as causing unpleasant odours, a clogged filter can represent a fire hazard.
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SS30-032
SS30-033
SS30-034
SS30-035
SS30-043
SS30-049
SS30-050
SS30-051
SS30-054
SS30-055
SS30-056
SS30-056A
SS30-057
SS30-058
SS30-059
SS30-060
SS30-102
SS30-103
SS30-104
SS30-105

Slide Stainer

Disposal of the instrument after final shutdown

Separate taking back of electrical and electronic instruments in the
European Union countries:

This is to be applied in the countries of the European Union and other
European countries with a separate collecting system within the waste
management.

This product, being an electro and/or electronic instrument, must be treated
separately within the waste management process (WEEE).

For non-European Union countries, the disposal of the instrument after final
shutdown must be done according to local laws in force

Replacement part codes for the SS-30 slide stainer

Power supply

“D” power cable (European)

“C-J” power cable (USA)

“ST-BUF5A” power cable (UK)
Activated carbon filter (5-unit pack)
Trough water inlet fitting (includes 1 m @6 mm tube)
Reagent trough

Water trough

Individual reagent trough cover
Stainless steel reagent trough cover set
Water supply hose (1.5 m)

Water supply hose (2 m)

Corrugated drain hose (3 m)

Stainless steel clip for drain hose

Rack holder

Plastic rack for 30 slides

User manual (includes PC software CD)
Spirit level

Tube cutter for @6 mm tube

USB cable for connection to PC

51



Slide Stainer

Programming form

PROGRAMME NO.:

NAME:

STEP

STATION

REAGENT

TIME

EXACT
TIME

DIP MODE

OO N[O|O|BR[WIN|—~
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